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Overview of the Laser Cutter
Midland Public Library (MPL) operates a single laser cutter which is manufactured by Dremel DigiLab and uses a 40W CO2 laser.  The laser cutter can engrave, score, and/or cut designs and shapes on flat surfaces using a wide range of materials.
Materials for laser cutting must either be provided by, or approved by, MPL in advance – do not plan on using your own materials without approval.  MPL allows the use of only the following materials:
	MPL/DigiLab LC40 Laser Cutter Allowed Materials

	
	Engrave
	Score
	Cut
	Comments

	Acrylic
	Yes
	Yes
	Yes
	Cut up to ¼” (6 mm) thick.  May require 2 passes.

	Birch Plywood
	Yes
	Yes
	Yes
	See above.

	Walnut Plywood
	Yes
	Yes
	Yes
	See above.

	Solid Maple
	Yes
	Yes
	Yes
	See above.

	Solid Oak
	Yes
	Yes
	Yes
	See above.

	Solid Walnut
	Yes
	Yes
	Yes
	See above.

	Cork
	Yes
	Yes
	Yes
	See above.

	Glass
	Yes
	Yes
	No
	

	Paper
	Yes
	Yes
	Yes
	

	Matboard
	Yes
	Yes
	Yes
	

	Cardboard
	Yes
	Yes
	Yes
	

	Rubber (laser grade)
	Yes
	Yes
	Yes
	

	Felt (wool)
	Yes
	Yes
	Yes
	

	Leather (untreated/unstained)
	Yes
	Yes
	Yes
	

	Cotton Fabric
	Yes
	Yes
	Yes
	

	Denim Fabric
	Yes
	Yes
	Yes
	

	Anodized Aluminium
	Yes
	Yes
	No
	Removes anodized layer.



See Table 2 on page 10 of Digilab LC40 Laser Cutter Operating/Safety Instructions for a list of materials that are prohibited from use.  Using any of these materials will cause health and safety issues and damage the laser cutter.   See Appendix A. 

The laser cutter can accept the following sized material:

For engraving – up to 18.4” x 12” (467 mm x 304.8 mm),
For cutting and scoring – up to 20” x 12” (508 mm x 304.8 mm),
Maximum engraving height/thickness -  1.25” (32 mm) after removing honeycomb.


Features of the LC40 Laser Cutter
1. LC40 Control Software.  The laser cutter has its own Control Software, which is accessed through a web browser (at address 10.20.19.1) using any computer connected to the MPL network.  More than one computer can access the Control Software at any time, but only one computer can control the cutter at a time.
2. Built-in high resolution camera.  This has two uses within the LC40 Control Software:
a. To display the location of the workpiece so that imported project files may be aligned correctly over the workpiece.
b. Used to capture graphic images from objects placed in the laser cutter.  These images, once captured, may be used, or Traced, to create cut and/or engrave project files in the same manner as an imported external file.
3. Project File Manipulation.  Once the graphic file(s) have been imported, the LC40 Control Software allows the user to:
a. Align the project with the workpiece,
b. Align the project files with each other if multiple images are being cut or engraved,
c. Copy the project to multiple places on the workpiece.
4. Pre-Defined Laser Parameters.  For a wide range of acceptable materials the LC40 Control Software sets the parameters to control the laser for cutting, scoring and/or engraving.
Overview of Process to Create a Project
1. Design the project using one of the following two methods:
a. Typically, the project is created and saved as a design file using an external graphic software package, e.g. Inkscape, Microsoft Paint, digital camera, etc.
b. Simply create/source a paper based graphic of the project.   This graphic can be ‘imported’ into the LC40 Control Software using the in-built camera in the laser cutter. 
2. Place the flat workpiece on the honeycomb lattice inside the laser cutter.
3. Unlock the laser head, focus the laser on the workpiece using the small round black puck and re-lock the head.
4. Either import the project file or create the project as in Step 2 above using the in-built camera.
5. Align your project image with the workpiece using the LC40 Control Software.
6. ‘Run the perimeter’ and view the moving laser to ensure the workpiece encompasses the image.
7. Select the material of the workpiece and confirm all of the parameters controlling the laser cutter for cut, score and/or engrave.  Ensure that all operations will be performed in the correct sequence.
8. Send the project as a Job from the LC40 Control Software to the laser cutter.
9. Confirm and complete the system/safety checks performed by the laser cutter.
10. Run the Job from the control panel of the laser cutter.
11. Remove the finished project and scrap material.  Clean inside with vacuum cleaner.
12. Save/Download the project as a .bin file on the web browser computer if it is required for future use.
Types of Graphics Files for a Project
For a project, the laser cutter determines which lines or images to cut/score or engrave based on the file types imported by the LC40 Control Software.  The following two graphic file types are used by the laser cutter:
a) A file that contains vector (point-to-point, simple line) information.  This file type is used for cutting or scoring.
b) A file that contains image (raster, area) information.  This file type is used for engraving.
The following table shows the relationship between supported file extensions and file types.
	Extension
	File Type
	Used for
	Cut or Score
	Engrave
	Example application to create file

	.svg
	Vector
	Line
	Yes
	No
	Inkscape,  Adobe Illustrator

	.pdf
	Vector/Image
	Line/Area
	Yes
	Yes
	Inkscape, Adobe Acrobat

	.jpeg
	Image
	Area
	No
	Yes
	Digital Camera

	.png
	Image
	Area
	No
	Yes
	Microsoft Paint



Using Graphic File(s) for a Project
A Job in the LC40 Control Software consists of one or more graphic files sent to the laser cutter for it to process and create the project.  Selecting and running the Job, using the control panel on the laser cutter, completes the project.  The laser cutter stores the last 10 Jobs sent to it from the LC40 Control Software for re-use.
The Control Software allows multiple files of different types to be imported into it so that a single Job may be created to, for example, first engrave and then to cut the workpiece, to complete the project.  The Control Software allows the user to determine in which sequence the imported cut and engrave files are executed by the Job.
In some cases, the order in which the laser cutter cuts the material is critical, i.e., typically all ‘inside’ cuts are made first before the ‘outside’ cuts release the completed project material from the scrap material.  The Control Software uses the color of the cut lines in the vector files to group the cut lines into a priority sequence or cutting order.  This sequence may be modified in the Control Software before the Job is sent to the laser cutter.  The default cut line color sequence is, first to last, orange, red, green, blue, yellow.  To control the depth of engraving on different areas of the workpiece then many image files are required – one for each area/depth of penetration.
When importing .pdf files into the Control Software, the software automatically determines which lines in the image are to be cut and which lines/areas are to be engraved.  In effect the Control Software  splits the single .pdf into two ‘sub-files’, one for cut/score and one for engrave, which are added to the Job to make the project.  These two sub-files may be accessed and manipulated by the user with the Control Software in the same way as two different imported image files.

Developing Graphic File(s) for a Project
First analyze the project to determine;
a) Which areas will need to be engraved?  Where will this image file(s) come from?
b) Which edges will need to be cut?  Which lines will need to be scored?  In what order will the scoring and cutting be performed in?  Where will this vector file(s) come from.
In the following section the graphic file used can either be imported from an external system or it can be created using the Trace feature described above.  
The LC40 Control Software is very flexible, especially when used in conjunction with powerful graphic file editors.  The following describes some methods for developing graphic files, depending upon the nature of the project.
1. Only engrave a workpiece.  Create one or many image files and import them into the Control Software.  Once each image file is imported, the Control Software will allow you to align the images (with each other and the workpiece) and set the laser parameters for each image file.  All of the ‘image files’ will be sent to the laser cutter as one Job.
2. Only cut a workpiece.  Create one or many vector files and import them into the Control Software.  Once each vector file is imported, the Control Software will allow you to align the cut lines (with each other and the workpiece), prioritize the order of cutting and set the laser parameters for each color of line in the vector files.  All of the vector files will be sent to the laser cutter as one Job.
3. Engrave and cut a workpiece.  There are many approaches to achieving this depending upon the complexity of the project and the functionality of your graphics editor:
a) Prepare multiple files with the cut lines on a vector file(s) and the engraved lines on an image file(s) as per #1 and #2 above.  Import all files in the Control Software, align the cut lines and images, prioritize the order of cutting and engraving, prioritize the order of cutting lines, and set all of the laser parameters.  Send all of the files to the laser cutter as one Job.  This approach of using multiple files for cut and engrave has the following disadvantages:
i) The user has to create, manage, and maintain many files for a single project.
ii) The user has to manually align all of the files in relation to each other within the Control Software. 
iii) Many different software packages may be required to create the vector and image files.
b) Prepare a single file using a graphics package that can draw on virtual layers and can also save the project as both an image file and a vector file, such as Inkscape - a free open source graphics editor.  In this case, create two layers in Inkscape, one for all cut lines and one for all engraved areas.  ‘Switch off’ the cut line layer and save the drawing as a .png/image file.  ‘Switch on’ the cut line layer, ‘switch off’ the engraved area layer and save the drawing as a .svg/vector file.  Import both of these files into the Control Software, prioritize the order of cutting and engraving, prioritize the order of cut lines and set all of the laser parameters.  Send the two files to the laser cutter as one Job.
The files saved from the two different layers of Inkscape will typically have two different reference datums when read into the Control Software, and so they will not perfectly align without some manipulation in the Control Software.  One way to overcome this alignment issue is to draw a small reference object outside of the maximum cut area and in the same place on all of the layers used.  This object will now appear in all of the saved files, in the same place, and will serve as a common reference datum for the Control Software.
c) Use Inkscape to create a .pdf graphic file which is treated by the Control software as a combined cut/score and engrave file.  Use the following approach:
i) Create at least three layers in Inkscape in the following order – Cut Layer(s), single Cut Hider Layer and Engrave Layer(s), with the Engrave Layer(s) on the top.
ii) Set the Opacity percentage of each layer: Engrave Layer(s) = 99%, Cut Hider Layer = 99% and Cut Layer(s) = 100%
iii) On the Cut Hider Layer, create a single rectangle larger than the Inkscape document and set the Fill to ‘White’ and Stroke to ’None’.
iv) ‘Switch off’ the Cut Hider Layer and draw your objects on the appropriate Cut and Engrave Layers.  Use No Stroke for objects on the Engrave Layers.  Use No Fill and different color Strokes for objects on the Cut Layer (s) to represent the cut sequence in the Control Software.
v) Save your file as an Inkscape .svg file for future reference.
vi) ‘Switch on’ the Cut Hider Layer and all of the cut lines below the Cut Hider Layer will now disappear.
vii) Save the file in Inkscape as a .pdf file.
viii) Import this .pdf file into the Control Software ensuring you import ‘Everything’ – cut and engrave.
ix) In the Control Software, prioritize the order of cutting and engraving , prioritize the order of cut lines, and set all of the laser parameters.  Send the two sub-files to the laser cutter as one Job.


To Engrave a Photo
Use the following steps to engrave a .jpg photo using the greyscale engraving feature on the laser cutter.  The steps can typically be done using your favorite photo editor software or they can be done using Inkscape.
1. Crop and/or size the photo to the requirements of your project.
2. Remove any background objects in image as desired.
3. Convert to a greyscale image.  In Inkscape use Filters>Color>Greyscale.
4. Sharpen image.  In Inkscape use Filters>Image Effects>Sharpen/Sharpen More.
5. Save the image as a .jpg or .png file type.
6. Load workpiece into printer and focus laser.
7. Select material using the Control Software.
8. Import image into the Control Software.
9. Align image with workpiece.
10. Verify/adjust laser parameters using the greyscale controls.
11. Send Job to laser cutter.
Tips and Tricks for Using the Control Software
1. An object in Inkscape may have properties for both its Fill (body) and its Stroke (edge).  These Stroke lines may create unwanted cut lines.
2. If an unwanted cut line exists, it may be possible in the Control Software to set that line color to zero Passes, or zero Power, to stop the laser from cutting the line.
3. Many image files contain an excess of ‘transparent background’.  In Inkscape, use Path/Trace Bitmap to remove this background and allow regular manipulation of the object.  
4. When the Control Software imports a file it constructs a maximum size rectangle around the image.  All of this rectangle must be within the cutting or engraving area of the bed of the machine otherwise you will not be able to send the Job to the laser cutter.  Remember, the useable engrave area is smaller than the cut area in the left/right direction.
5. The Image Capture functionality for aligning the image and the workpiece is not ‘super’ accurate.  Before sending a Job to the laser cutter move the laser head using the Control Software to reference points on the image and go to the cutter to see if the red laser dot is positioned correctly on the workpiece.  The alignment between this red dot and where the laser actually cuts the workpiece is typically better than 1 mm.
6. Create a file/document in your graphics package that contains the maximum size for the laser cutter bed and all the Layer settings.  Use this file as a template when starting new projects.
7. Cut Lines are always minimal thickness (kerf) on the workpiece regardless of line thickness on the imported graphics file.
8. An engraved line on a workpiece will look very similar to a scored line.
9. For complex projects, first test the Job on a paper or card workpiece.  Ensure that the correct laser parameters are selected for paper or card.
Costs
Lasering your designs at MPL costs $2.00 for an area of 3 inches by 3 inches on materials the library provides, or $1.00 + $1.00 per hour on your own materials.
Note:  The laser within the LC40 has a finite operating life before it has to be replaced.
Materials for laser cutting, vinyl cutting, and 3D printing must either be provided by, or approved by, MPL in advance – do not plan on using your own materials without approval.

Approved materials may be obtained from:
Acrylic – plasticworld.ca
Baltic Birch Plywood - www.stockade.ca


Appendix A - Materials not to be Laser Cut or Engraved

	MATERIAL
	DANGER
	CONSEQUENCE

	PVC (Poly Vinyl Chloride, a.k.a. vinyl)) 
	Emits pure chlorine gas.

	Gas will ruin lens, corrode metal, and ruin motion control system.

	Pleather/Artificial leather 
	Emits pure chlorine gas.

	Gas will ruin lens, corrode metal, and ruin motion control system.

	Moleskin Notebooks 
	Emits pure chlorine gas.

	Gas will ruin lens, corrode metal, and ruin motion control system.

	Polycarbonate/ Lexan
	Cuts poorly, discolors, fire risk.
	This material absorbs infrared radiation, so the laser is very ineffective.

	ABS (Acrylonitrile butadiene styrene)
	Emits cyanide gas and melts into the machine.
	Abs tends to melt, making a mess. It also has a higher chance of catching fire.

	HDPE (High Density Polyethylene)
	Catches fire and melts.

	It melts, tending to make a mess and ruin the material tray.

	Polystyrene Foam
	Catches fire.
	It catches fire and it melts.
This is the #1 material that causes laser fires!!!

	Polypropylene Foam

	Catches fire.

	Like Polystyrene, it melts, catches fire, and the melted drops continue to burn and turn into rock-hard drips and pebbles.

	Fiberglass

	Emits fumes.

	It's a mix of two materials that can’t be cut.
Glass (engrave, but not cut) and epoxy resin (fumes).

	Coated Carbon Fiber

	Emits noxious fumes.

	A mix of two materials.  Thin carbon fiber mat could be cut, with some fraying - but not when coated.

	Mirrored surfaces
	
	Will not work.

	Wood that has been coated, fumigated, pressure treated or stained
	Potential to emit noxious fumes.
	

	Any painted or varnished material
	Potential to emit noxious fumes.
	

	Any powder

	
	Compressed air from laser head will blow it away.

	Butane lighters
	Explode, catch fire.
	

	Gasoline or other flammable liquid containers
	Explode, catch fire.

	

	People / Animals
	Catch fire, burn, blind.
	Let’s be serious!
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